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About this guide

This guide focuses on the two critical steps required for a successful Chrome Browser deployment:

e Configuration—The considerations and decisions to build an installation package to deliver to each
user.

e Deployment—The timing and testing requirements for an installation package to deploy Chrome
Browser.

This guide focuses on the Windows Installer (MSI) version of Chrome Browser for enterprise, which is
available for Microsoft Windows 7 and later. It's possible to install a managed version of Chrome Browser
for Linux-based systems and to configure device-based policies on a Mac, but these configurations will not
be covered in this guide.

This guide covers cloud-based policies and Legacy Browser Support. For more in-depth documentation,
refer to the Chrome Enterprise Help Center.

The recommendations in this guide on deploying Chrome Browser in an enterprise setting were gathered
through our work with a variety of clients and environments in the field. We thank our customers and
partners for sharing their experiences and insights.

What's covered Instructions, recommendations, and critical considerations for deploying
Chrome Browser in an enterprise environment

Primary audience Microsoft Windows administrators

IT environment Microsoft Windows 7 and above

Deployment phases Core IT, Early Adopter

Takeaways Best practices checklist for the critical considerations and decisions of a

Chrome deployment

Last updated: May, 20179.
Location of the Document: https.//support.google.com/chrome/a/answer/3115278

Third-party products: This document describes how Google products work with the Microsoft Windows operating systems and the
configurations that Google recommends. Google does not provide technical support for configuring third-party products. GOOGLE
ACCEPTS NO RESPONSIBILITY FOR THIRD-PARTY PRODUCTS. Please consult the product's Web site for the latest configuration and
support information. You may also contact Google Solutions Providers for consulting services.

©2019 Google LLC All rights reserved. Google and the Google logo are registered trademarks of Google LLC. All other company and
product names may be trademarks of the respective companies with which they are associated. [CHROME-en-2.0]
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Introduction

Chrome Enterprise lets you deploy and manage Chrome Browser for your organization. It consists of
Chrome Browser and a set of admin tools, resources, and installer packages which allow an IT
administrator to deploy and manage Chrome Browser in an enterprise environment. The admin tools allow
administrators to configure, package, and deploy Chrome Browser at the system level, and manage policies
on an ongoing basis.

Chrome Browser offers the user many configuration options and settings to personalize and enhance their
web browsing experience. When deploying Chrome Browser, the administrator can control Chrome
Browser default settings and policies using the following methods:

e Policies: Can be used to enforce and maintain settings on client computers. For example, you can
enable auto-updates, and set the update interval, the default search engine, and the default
browser.

e Preferences: Can be used to set the default value for particular setting, while still allowing the user
flexibility to change the setting. For example, you can set the user’s default homepage to the
company intranet, set the home button to display in their toolbar, or allow the bookmarks bar to
display in the toolbar.

For information about how to deploy master preferences on users’ computers, see Use master preferences
for Chrome Browser in the Chrome Enterprise Help Center.

Chrome Browser Deployment Guide | May 2019 4


https://support.google.com/chrome/a/answer/187948
https://support.google.com/chrome/a/answer/187948

6 chrome enterprise

Configure Chrome Browser Options

Best Practices Summary

e Use Group Policy Objects (GPOs) and cloud policy over preferences when possible. Unlike policies,
preferences do not apply to previous installations of Chrome Browser and are only applied to a
single profile. Policies also override any preferences settings for a feature. Also note that the
master_preference file can be changed and not enforced like group policies can.

Remember that GPO is a machine policy. For example, GPO applies to any user that uses the
computer, whereas cloud policy is tied to the user, and it only applies if the user is signed in to
Chrome Browser on their computer.

e We strongly recommend enabling Chrome Browser auto-updates (this is the default policy setting)
to ensure that users have the latest features and security fixes.

Legacy Browser Support

If your organization wants to take advantage of the Chrome Browser, but your users still need to access
legacy websites and web apps that require Microsoft Internet Explorer, you can use Legacy Browser
Support to easily switch between browsers. When users click a link in Chrome Browser that requires a
legacy browser to open (such as a website with an embedded ActiveX control), the URL will automatically
open in the legacy browser.

Administrators can specify which URLs to launch into a legacy browser and deploy this Chrome policy for
the organization. For information, see Legacy Browser Support for Windows.

Chrome Browser Cloud Management

You can use the Google Admin console to manage Chrome Browser on Windows, Mac, and Linux devices
running Chrome Browser version 73 or later.

With Chrome Browser Cloud Management, you can:
e Enforce 100+ Chrome policies for all users who open Chrome Browser on a managed device. Users
don't have to sign in or have Google Accounts to receive policies.
e Block suspicious extensions across your organization and do other common IT tasks.
e View reports on Chrome Browsers deployed across your organization, including each browser's
current version, installed apps and extensions, and enforced policies.

For instructions on how to enroll devices and manage Chrome Browser, see Set up Chrome Browser Cloud
Management.
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Policies and Templates

Chrome policies are applied differently depending on the client operating system.

After selecting the right template for the target environment, the administrator needs to define which
Chrome policies will be enforced in the enterprise environment. The Chromium.org site lists the supported
policies for Chrome Browser and can be applied via policy templates. For information about how to install
and configure policy templates, see Set Chrome Browser policies on managed PCs.

Windows

Use ADM or ADMX templates to manage Chrome Browser using Group Policy. For Windows Vista and later,
use ADMX templates. Consult your Windows support provider if you need help to decide which templates
you should use in your organization.

ADM and ADMX templates do not automatically update. You need to download and install the latest
administrative templates.

There are three types of Chrome policy templates released: Stable, Beta, and Dev. With Beta and Dev
templates, you get access to policies that are scheduled for future releases. This lets you test policies that
are not yet available in the Stable template. Whichever template channel you use, the policies that you
configure apply to all Chrome Browser releases—Stable, Beta, Dev, and Canary.

There are separate templates for Chrome Browser, Google Update, and LBS policies. You might need to use
them all to manage your Chrome Browser deployment. The specific template being discussed in this guide
will be called out as we discuss each one.

MacOS X

Use a .plist (property list) file to set Chrome policies. Use your preferred systems management tool to push
the file to client Macs. For instructions on how to manage Chrome Browser on Mac computers, see the
Mac Quick Start Guide.

Linux

Use a JavaScript Object Notation (JSON) configuration file to set Chrome policies. Use your preferred
systems management tool to push the file to client PCs. For instructions on how to manage Chrome
Browser on Linux Computers, see the Linux Quick Start Guide.
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Cloud Policies

In addition to machine-based policies, you can optionally provide users with the convenience of having their
open tabs, bookmarks, and theme synced with any PC where Chrome Browser is installed.

Additionally, administrators can define pre-installation of Chrome apps, extensions, and themes when users
sign in to Chrome Browser.

These cloud policies are defined by administrators in the Google Admin console and include many of the
policies that are available via the Chrome policy template deployed by GPO. These policies apply to users
on any PC where the user signs in to Chrome Browser with their Google Account.

If you're a G Suite customer or have Chrome licenses, you can use cloud policies to manage Chrome
Browser for your users.

Administrators with access to the Admin console can synchronize users and their passwords with their
LDAP server to manage user policy. More information can be found below:

e (Google Cloud Directory Sync (GCDS)—-Automatically add, modify, and delete users, groups, and non
employee contacts to synchronize the data in your G Suite domain with your LDAP server.

e G Suite Password Sync (GSPS)—-Automatically keep your user's Google account password in sync
with their Microsoft Active Directory passwords.

Cloud policies are deployed and updated anytime the client has Internet connectivity. Unlike the typical GPO
policy push scenario which requires the PC to have LAN or VPN connectivity to the Active Directory
controller, cloud policies can be pushed when the client PC has a connection to the public Internet. For
information about how to manage policies from the cloud see Cloud-managed Chrome Browser.

Note: Machine policies (GPO) take precedence over cloud policies when there’s a conflict. For details, see
Set Chrome Browser policies on managed PCs.
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Master Preferences

Administrators can use master preferences to deploy default preferences to Chrome Browser users on
managed computers.

When users launch Chrome for the first time, the user’s preference file is copied from the

master preferences file. We recommend you validate the master preferences file with a JSON
validator and formatter prior to deploying. After the master preferences file has been verified, package
it with the Chrome installation for deployment.

For details, see Use master preferences for Chrome Browser.

Privacy

The Google Chrome Privacy Notice describes how we treat personal information when you use Chrome
Browser and associated services such as Safe Browsing. You can review the latest version here, which
outlines the data collected based on the feature being used.

Note that in many cases, specific features can be disabled by the user or via policy to minimize the
information sent to Google. These include but are not limited to:

Chrome Sync with SyncDisabled

Omnibox search suggestions with SearchSuggestEnabled

Translate feature with TranslateEnabled

Spellcheck feature with SpellCheckServiceEnabled

Autofill feature with AutoFillEnabled

Anonymous usage statistics and crash reports to Google with MetricsReportingEnabled
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Chrome Browser Deployment

Methodology

Enterprise software deployments require a phased roll-out to capture and resolve any issues before
deploying the software company-wide. We recommend you deploy Chrome Browser in a structured
approach with the following phases: Development, Partial Deployment, and Full Deployment. This
multi-step approach allows you to evaluate the deployment at each stage and make necessary changes.
Below are some of the tasks that should be performed in each Chrome Browser deployment phase:

Google Chrome MSI
K feedback loop Package development
e
Partial
Deployment

Testing Preferences, Identifying a subset of

Policies, Windows Base platforms, users, business Deploy to the entire user-

Image, Deployment, groups lo test the base
\ Shortcuts, etc. deployment /

Prepare your installation package

Chrome Browser uses a standard MSI installer package and can be deployed via standard Windows
deployment tools. Software deployment tools can bundle the MSI, preferences, bookmarks, and extensions.
Some of the most common distribution methods are:

e Active Directory Group Policy Management
e HP Client Automation
e Microsoft System Center Configuration Manager

Use software delivery mechanisms to package, deliver, and maintain distributions of Chrome Browser.
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Installation Process

Chrome Browser installations from an MSI package are installed at the system level and are available to all
users. As a result, any user-level installation of Chrome Browser, (i.e. a user's own Chrome Browser
installation), will be overridden. Here’s where Chrome Browser is installed and linked for the two types of
Chrome Browser installers:

e User Level: “%USER DATA%\Google\Chrome\Application\"
e System Level: “Program Files\Google\Chrome\Application\"

Note: Chrome Browser will not allow an older version to be installed over a newer version. Any MS| of
Chrome Browser needs to be newer than the version already deployed (for example, Chrome 68 cannot
overwrite Chrome 69).

Test Your Installation Process

Some users might have downloaded and installed Chrome Browser prior to your enterprise installation, and
there will be a previous “user level” installation. In this case, Chrome Browser will install for all users and
leave the user data (preferences, cache, etc.) untouched, unless you choose to have your distribution
software uninstall any previous installations. It will also attempt to repoint all of the default shortcuts to
point to the new system level installation.

Important: Test your Chrome Browser installation process to make sure it works correctly on your
organization’s Windows image and method of software distribution.

Application Globally Unique Identifiers

When Chrome Browser is installed, it is entered into the Windows Registry with an Application Globally
Unique Identifier (GUID). There will also be a parent GUID for the Chrome binaries. Any Registry changes
you wish to make should be made to the parent GUID, especially as it relates to automatic updating.

In Windows you can find these in the registry in these locations:
e Chrome Binaries

{HKLM | HKCU}\Software\Google\Update\ClientState\ {4DC8B4CA-1BDA-483E-B5FA-D3C12E1
5B62D}

e Chrome

{HKLM | HKCU}\Software\Google\Update\ClientState\ {8A69D345-D564-463c-AFF1-A69D9E5S
30F96}

Important: The Chrome Binaries GUID will become the default for all installations. However, previous
settings for an individual GUID will be maintained.
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Summary: Best Practices for Installation and Updates

Chrome Options

e |eave auto-update enabled for Chrome Browser.
o Auto Update will provide the latest security updates.

Methodology

e Use a phased approach to test and deploy Chrome Browser.
o To ensure that there is no regression or loss of functionality for your users, have your IT
group test the beta and dev channel of Chrome Browser.
m The beta channel gives a 4-6 week feature complete preview of the next stable
Chrome release.
m The dev channel gives a 9-12 weeks preview of what's coming next - Keep in mind
that the dev release may not be 100% stable.

Installation

e Customize the branding of the application with its shortcut text and icon through your software
distribution mechanism.

Logging

e Increase logging for Windows installation to troubleshoot problems.
e Increase logging of your distribution software to log successful and failed installations.
e Use the logs created by the Chrome Browser installation to troubleshoot errors.

Chrome Browser Updates and Bandwidth

e Account for the increased network traffic for automatic updates to Chrome Browser.
Stagger your client installations so they don't all update at once.

e Delta updates between releases are typically only a few megabytes as opposed to a full update
which is ~20 MB.

e Thereis currently no built-in facility for rate-limiting auto-updates or forcing them across several
days. Multiple group policy objects (GPOs) can be set for segregated organizational units to
customize the AutoUpdateCheckPeriodMinutes parameter to a different value for each
organization to ensure scattering of auto-update checks.
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Configuration Options

You can make Microsoft Windows-related changes to your deployment through the software management
system you have chosen.

A common option might be changing the icon image, text, and placement of a Chrome icon on the desktop.
These options and others are done through your software management as they don't specifically apply to
the configuration of Chrome Browser itself.

Logging

There are two key points where logging data can be beneficial in any troubleshooting process. Each point is
dependent on the amount of information you would like regarding the distribution and subsequent updates
of Chrome browser.

Software Distribution
The software distribution packages mentioned above all have varying levels of logging capabilities.

Depending on your need for this information, it is important to configure it to a point where you can confirm
the success or failure of the installation, and any status codes or errors returned by the MSI. For details,
see Command-Line Options.

Chrome MSI
The MSI itself can also be configured to increase its logging verbosity to provide more clarity on the

success or any failure. It's important to understand why a particular installation of the MSI failed.

Separately, the logs created by the Chrome Browser installation are defaulted to the highest verbosity level
and located here:

o %TEMP%\chrome_installer.log

Important: TEMP% should be the System temp directory and not the user-level system variable.
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Chrome Browser Updates

There are two important aspects to updating Chrome Browser: Google Update (based on Omaha) and
Network usage.

We highly recommended you allow Chrome Browser to auto-update. For two primary reasons:

1. Access to the latest security patches and bug fixes
2. Support is only provided on the latest release of Chrome Browser

For more information on auto-updates, see Manage Chrome updates (Windows).

Track Chrome Updates
Follow the Chrome Release blog to stay up-to-date on the latest changes to Chrome Browser.

Google Update
Chrome uses an update engine called Google Update. While you can configure the update frequency, it's

important to understand what logging options are available when troubleshooting updates to Chrome
Browser.

If you encounter issues updating Chrome Browser, do the following:

1. Enable verbose logging in Google Update
2. Invoke '‘GoogleUpdate.exe /update’
a. e.g,OnWindows 7 itis located at “Program Files > Google > Update”
b. Additional switches to GoogleUpdate.exe are located here
3. Recover the update log
a. e.g,OnWindows 7 itis located at “Program Data > Google > Update > Log"

There will also be a folder for each version installed here:
e C:\Program Files (x86)\Google\Chrome\Application

Google Update Policies
Note that there’s a separate set of policies (and templates) for Google Update outside of Chrome Browser.

For more information on managing updates to Chrome Browser, see Manage Chrome updates (Windows).

Network Bandwidth
Be mindful of network bandwidth requirements for updating Chrome Browser. You can expect a new

Chrome release every six weeks. Caching can be enabled via policy if your network infrastructure supports
caching of update files.

The initial Chrome Browser installation is approximately 50 MB. Subsequent updates from one version to
the next are approximately 10—15 MB. Patch updates are typically 3—5 MB. Updates from a major version
to a later non-consecutive major version usually require a new complete installation.
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Installation Procedure for Chrome Browser

This procedure covers the general installation of Chrome Browser for enterprise and updating group
policies in a Windows environment with domain-joined computers. Screenshots and detailed setup steps
are for Windows Server 2012 R2 Standard and are for illustration purposes only.

You can download the standalone Chrome MSI or the Chrome Enterprise Bundle. The bundle contains
Chrome MSI and administrative policy templates. For more information, see Download Chrome Enterprise
Bundle.

The scenario assumes two machines: (server) and (client), both on the chromeforwork.com Active
Directory domain.

Create a Distribution Point

To publish or assign a computer program, you must create a distribution point on the publishing server:

1. Log on to the server computer as Administrator.

2. Download the latest Chrome Browser MSI package from
https://cloud.google.com/chrome-enterprise/browser/download/

3. Create a shared network folder where you will put the Microsoft Windows Installer package (.msi
file) that you want to distribute.
Note: This share MUST be accessible by your client machine. The client machine will request the
file from this location. Verify the share is working correctly.

4. Set permissions on the share to allow access to the distribution package.

Configure Chrome Policies

Note: The instructions are for manually adding a GPO template if you are not using centralized GPO
storage. If you are using centralized GPO storage, please unpack and save ADM/ADMX policy templates for
Chrome Browser to where your local administrative GPO templates are stored (e.g.
C:\Windows\PolicyDefinitions). If you do so, you can skip step 5 below.

To add Chrome policies to the deployment:

1. Download the latest ADM/ADMX policy templates for Chrome Browser from
https://dl.google.com/dl/edgedl/chrome/policy/policy_templates.zip.

2. Load the Group Policy Management Tool.
Go to Server Manager > Tools > Group Policy Management.
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3. Navigate to your domain to create a GPO object.
a. Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com.
Right-click chromeforwork.com and select Create a GPO in this domain...
Create a new GPO policy called Chrome Browser for Work.

ﬂ File Action View Window Help

rMNEEEIEREL

|2 Group Policy Management chromeforwork.com
F ’ﬁ F_::rest: chromeforwork.com Status | Linked G Policy Objects | Grone Bk e
4 [ZL Domains
A Z'Efi chromefonwgecar | g
7 Default D Create a GPO in this domain, and Link it here... v Benckin st SV
Eﬂ Test Defa Link an Existing GPO...
Ifﬁ Test Polic | Block Inheritance
= - | G Policy Mod I'_W' d.
2 roup Poli odeling Wizard...
b ':%i' Group Po 5 cy : g:- orwork.com is the baseline do
I ;‘; WM Filte | Mew Organizational Unit
[+ .__E Starter GP .Searchmm -
b [ Sites |s) with replication in progress

Change Domain Controller...

'ﬁf Group Policy Mo

E Group Policy Res Remove

Is) with replication in sync
Active Directory Users and Computers...

View 3
Mew Window from Here
Refresh

| Properties

Help Geni

Create a GPQ in this domain and link it to this container

Mame:
|Chrome Browser for Work |

Source Starter GPO:
|{none} W |

0K | | Cancel |

Chrome Browser Deployment Guide | May 2019 15



CO. chrome enterprise

4. Navigate to the newly created GPO object.
a. Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Chrome Browser for Work.
b. Right-click Chrome Browser for Work and select Edit to load the Group Policy
Management Editor.

5 File Action View Window Help

o= nE X H=

|3 Group Policy Management Chrome Browser for Work
4 & Eorest‘. chFomefonnrork.com Scope |Deta'r|s | Settings |Delegation |
4 ﬁ Domains
Links
4 ﬁ chromeforwork.com
h'fér Chrome Browser for Wes! Display linkes in this location: | chromeforwork .com
Iff..r Default Damain Policy b sins, and OUs are linked to this GPO:
b Test Default Enforced = Som——r
I f;ij Domain Controllers Link Enabled Noo
B E Group.Pollqr Objects Save Repants
B [ WMI Filters I :
[ @ Starter GPOs View 4
I Ca Sites Mew Window from Here
é‘ﬂ Group Policy Madeling I Bl.can orly to the fallowi
o ; Delete apply ta the following groups, u
[ Group Policy Results =
Rename
Refresh ¥
s (CHROMEFORWORK\Domain Compute
Help
| Add... | | Remove | | Propertie
WMI Filtering
This GPO is linked to the following WMI fiter:
| <none: v

Open the GPO editor

Chrome Browser Deployment Guide | May 2019 16



6 chrome enterprise

5. Add the Chrome ADM/ADMX policy template for Chrome Browser to the GPO object in Group
Policy Management Editor.
Note: This step can be skipped if you are using centralized GPO storage and have already saved
Chrome ADM/ADMX policy templates to centralized storage, as described in step 1 above.
a. Find Computer Configuration > Policies > Administrative Templates...
b. Right-click Administrative Templates, and select Add/Remove Templates.

File  Action View Help

= FE= HB=

Chrome Browser for Work [201:z

4 f& Computer Configuration i S e
4+ [ Policies Select an item to view its description, Mame

C uter Cont
b | Software Settings & Computer Con

b [ Windows Settings #%, User Configurat
B || Admin ]
& Add/R Templates...
i | Preference ; Y Senoie ] suplites
4 &, User Configur Filter On
i [ Policies Filter Opticns...
b (] Preference Re-Apply Filter
All Tasks 3
Help

c. Add the chrome.adm template via the dialog.

Cument Policy Templates:

Size  Modffied
478KB 4/27/2016 1:17 ...

d. Once completed, a Google / Chrome folder will appear under Administrative Templates if
it's not there already.
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6. Enforce the GPO object.
a. Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Chrome Browser for Work.
b. Right-click Chrome Browser for Work and select Enforced.

5 File Action View Window Help

e« 2w X 6| B

5 Group Policy Management Chrome Browser for Work
A ﬁ E?rest: ch_romefomork.com Scope |Detai15 | Seftings | e |
4 [£3 Domains
Links
A ﬁé chromeforwork.cam
sty Chrome Browser for Wienrle | Display links in this location: |d1romefcrwcrk.ccm
E=ﬁ.r Default Domain Poli | Edit... omains, and OUs are linked to this GPO:
5a Test Default Enforced =
] : e Enforced
p 2| Domain Controllers Cink Enabled = Yes
3 E Group Policy Object | s BRSO
b (% WMI Filters . s .
b [ Starter GPOs View 3
r -;? Sites Mew Window from Here
5% Group Policy Modeling ' PO can only apply to the following groups, us
= : Delete
|+ Group Policy Results =
Rename
SErs
i rs (CHROMEFORWORK\ Domain Compute:
Help
| Add... —| | Remove | | Properties
WMI Filtering
This GPO is linked to the following WMWI filter:
|<mne> v

Toggle the Enforced attribute for this link
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Change the configuration settings for the target group of users

There are many policies you may want to control. For the purposes of this guide, we will walk through the
steps of setting up homepage and disabling anonymous usage metric collection. These are two policies
administrators commonly set up. A full list of supported policies is at
http://www.chromium.org/administrators/policy-list-3.

1. Navigate to the newly created GPO object in the Chrome Management Policy Editor.
a. Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Chrome Browser for Work.
b. Update the policies defined in the Chrome template as needed:

File Action View Help

e rnEl 2 HE T

4 [ | Administrative Templates: Policy definitions (ADMX fil ~ _ .
¢ [ Control Panel I T— -
- Configure the home page URL Setting
b [ Mebwork T
e B Conture t
| Printers 2 ] : A
= Server ||| Edit policy setting [i2] Use MNew Tab |
] Start Menu and Taskbar Requirements:
b [ System Microsoft Windows XP SP2 or later
b 1 Windows Compeonents —
8 . i . escription:
A4 [ (ila ssic Administrative Terplates (ADM) L
4 Gfmgle URL in Google Chrome and
4[] Google Chrome prevents users from changing it.
] Allow Google Chrome Frame to handle | o
[ 7] Configure remote access options The home page is the page
= - opened by the Home button. The
|| Content Settings
7 pages that open on startup are
|| Default HTML renderer for Google Chro controlled by the
|| Default search provider RestoreOnStartup policies,
[ Extensions
2 e home page type can either be
|| Home page Theh page typ ither b
7] Locally managed users settings et 6.8 URL you specity Hem o
= : : set to the Mew Tab Page. If you
| Native Messaging || select the Mew Tab Page, then this
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2. Set the Home page.
This is the URL that users see when they first open the browser or click the “home” button.

a. Find the Home page folder under Google > Google Chrome and change the two policies:
m Enable a new homepage URL and provide a URL.
m  Make sure Use New Tab Page as Homepage is enabled.

@ Coenfigure the home page URL

| Previous Setiing | ‘ MNext Setting
(C) Not Configured Comment:
® Enabled
() Disabled
Supported on: [ picrosoft Windows XP SP2 or later
Options: Help:
Home page URL Configures the default heme page URL in Google

prevents users from changing it.
|http:."."news.google.com |

The home page is the page opened by the Home
pages that cpen on startup are controlled by the
RestoreCnStartup pelicies.

b. Find the Show Home button on toolbar policy under Google > Google Chrome:
m  Enable the policy.

3. Disable anonymous usage statistics and crash information.
Administrators can turn off sending any crash information or anonymous statistics to Google.

a. Find the Enable reporting of usage and crash-related data policy under Google > Google
Chrome:

m Disable the policy

Note: In both examples above, you can apply these policies at the device or user level by changing
the policy under Computer Configuration or User Configuration.
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Install Extensions Automatically (optional)

Another policy to try is to force install an extension automatically on Chrome. Let's try setting up
KeepAwake via the ExtensionInstallForcelist policy in the Extension set of policies.

The ID for the Chrome web store version is: bijihlabcfdnabacffofojgmehjdielb
The Auto-Update link needed is: http://clients2.google.com/service/update?2/crx

bijihlabcfdnabacffofojgmehjdielb http://clients2.google.com/service/update?/crx

a4 & Computer Configuration ”
4 [ Policies
b || Software Settings
b | Windows Settings
4 || Administrative Templates: Policy definition
- [ Control Panel

JI. {

—| | Configure the list of force-installed ~ Setting
apps and extensions liz| Configure allowed app/extension types

| Configure extension installation blacklist

-

Edit policy seffing. onfigure extension installation whitelist

b [ Network Requirements: onfigure extension, app, and user script install ¢
| Printers Microsoft Windows XP SP2 or later |iz| Configure the list of force-installed apps and ext
] Server e - - ;
| Start Menu and Taskbar escrpt Configure the list of force-installed apps

[ (| System Specifies| : . . :

b ) Windows Components sitension Configure the list of force-installed apps and extensions I@

4 [ Classic Administrative Templates (ADM silently,

8 Goool without | c .
4 [l Google which cal (O Mot Configured S

4 [ | Google Chrome user. All
| Allow Google Chrome Frame the apps/ (®) Enabled

|| Configure remote access opt implicitly] .

[ Content Settings _ || Interactiq (I Peatic < Sl -

=1 Default HTML renderer for G = || additiona UPPOEE ON: | picrosoft Windows XP SP2 or later

e ermissig

g' Default search provider :ersions

|| Extensions Furtherm| .

"] Home page granted f| Options: Help:

] Locally managed users settin enterprisg

—cx _ - enterprisq

J Native Messaging APIs. (Th{ | Extension/App IDs and update URLs to be silently T —

] Password manager : installed pECics et ol api

o B h available| | insta without user interacti

| Policies for HTTP authenticat are Al T

] Proxy server not force| Show... ;:aerrwlted i

] Startup pages implicitly, without us

p [ Google Chrome - Default Setting 1 E

(%2 Al Settings i

I || Preferences

4 ®, User Configuration
b L7 Policies
I || Preferences

Extension/fpp |Ds and update URLs to be silently installed

Value
bijinlabcfdnabacifofojgmehjdisl Hitp://clients 2. google. com/service /update 2/cnd

=

<| ] >

5 setting(s)

For privately hosted apps (i.e., not in the Chrome Web Store), use a string such as:
pckdojakecnhhplcgfflhndiffaohfah;https://sites.google.com/site/pushcrx/privatew

ebstore/extension info.xml
.. where the URL is specified to the internal app’s update.xml rather than the public-facing
clients2.google.com URL.

The policies can then be applied to the target users and/or machines. Depending on the network's

configuration, this may require time for the policy to propagate. Policies may be propagated manually by
running gpupdate on the client workstation.
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Now let's define which devices and users will be managed by the GPO policies we defined.

1. Navigate to the Chrome Browser For Work GPO object in the Chrome Policy Management tool

a.

Find Group Policy Management > Forest:chromeforwork.com > Domains >

chromeforwork.com > Chrome Browser for Work and select it.
2. Assign the GPO object to all devices in the domain.

a.

é; File Action WView Window Help

In the Security Filtering pane, click Add.

o= e 6 B

_ﬂ Group Policy Management
4 ﬁ Forest: chromeforwerk.com
P & Domains
4 3 chromeforwerk.com
Iiﬁ Chrome Browser for Work
2/ Default Domain Policy
Iiﬂ Test Default
I [&] Domain Controllers
[ ,:%’r Group Policy Objects
b [ WMI Filters
b (3] Starter GPOs
I |3 Sites
E‘ﬂ Group Policy Modeling
[ Group Policy Results

Chrome Browser for Work
Scope | Details | Settings | Delegation |
Links

Display links in this location:

| chromeforwork.com

The following sites, domains, and OUs are linked to this GPO:

-

Location Enforced Link Enabled
ﬁ chromeforwork.com Yes Yes
Security Filtering

The settings in this GPO can only apply to the following groups, users, and computers

Name i

B2 futhenticated Users
52 Domain Computers (CHROMEFORWORK \Domain Computers)

| Add... | | Remove | | Properties |

WMI Filtering

This GPQ is linked to the following WM filtter:

| ione: v | | Open |

In the Select User, Computer, or Group window, type the name of the object you want to

add, click Check Names (to verify the name you entered), and then click OK.

You can type Domain Computers to add all workstations and servers joined to this domain

(as shown in the example below) or you can specify a different group of computers.

Select this object type:
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Assign a Package

To install Chrome Browser on computers or users that belong to the domain:

1. Navigate to the newly created GPO object in the Chrome Management Policy Editor.
a. Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Chrome Browser for Work.
2. Under Computer Configuration, expand Software Settings.
3. Right-click Software installation, point to New, and then click Package.

File _&ctiorlu Vi:e?.\r_._He_lp_ -
L ERENCEE

'=[ Chrome Browser [2012R25TD.CIl| Mame ‘ Versi... Deploymentst.. Source

4 i Computer Configuration || 7 Google Chrome 86.164  Assigned 4201 2r2stdly
4[] Policies
4[] Software Settings
Software insta" -
b [ Windows Setting]___New e
b [ Administrative T¢ View »
I 7| Preferences I
4 ¥, User Configuration Eante
b | Palicies Refresh
- [5] Preferences Export List...
Properties
Help
<[ m [>][< m

Creates a new item in this container.

3. Inthe Open dialog box, type the full Universal Naming Convention (UNC) path of the shared
installer package that you want. For example,
\\server\Packages\GoogleChromeStandaloneEnterprise.msi.

a. Important: If you use the Browse button to access the location, make sure that you use the
UNC path to the shared installer package. Remember that the client machine will look for
the file at this specified location.

4. Click Open.

5. Click Assigned, and then click OK. The package is listed in the right pane of the Group Policy
window.

6. Close the Group Policy snap-in, click OK, and then quit the Active Directory Users and Computers
snap-in.

Note: At this point, you have created a policy to deploy and install Chrome on the endpoint and are
ready to test the installation.
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Make Chrome Browser the Default Browser (optional)

You can choose to set Chrome Browser as the default browser. Please take a look at the following
instructions for making Chrome Browser the default browser for different versions of Windows:

e Windows 8, 10 - Detailed instructions can be found here.
o Create a default application association XML file.
o Create a GPO policy (separate of Chrome Browser for Work policy).
o Set a default associations configuration file.
e Previous versions of Windows
o Enable the “DefaultBrowserSettingEnabled” policy.

Force users to sign in to Chrome Browser (optional)

You can force users to sign in to their Chrome profiles before they use Chrome Browser on a managed
computer. This ensures that the cloud policies that you set in the Google Admin console are applied on
users’ computers. You can force everyone in your organization to sign in or just specific users. You can
control who can save and synchronize Chrome Browser settings and data to their managed Google
Account.

For details, see Force users to sign in to Chrome Browser.

Manage Google Updates (optional)

You can manage how Chrome Browser handles auto updates with Google Update. There are two policies
that control Google Update’s general behavior.

e Auto-update check period override—use this policy to set the period of auto update checks.

e DownloadPreference—when enabled this policy can be used to cache updates to reduce external
network bandwidth. Use of this policy will result in the server responding with a payload that could
be cached by downstream proxies or similar types of content caching solutions. This is a best
effort policy and should be verified and tested.

For more details on these two policies, see Install and update Google applications.

1. Download the latest ADM/ADMX policy templates for Google Update from
http://dl.google.com/update?/enterprise/GoogleUpdate.adm or
http://dl.google.com/update?/enterprise/googleupdateadmx.zip

2. Load the Group Policy Management Tool:

a. Server Manager > Tools > Group Policy Management

3. Navigate to your domain to create a GPO object:

a. Find Group Policy Management > Forest.chromeforwork.com > Domains >
chromeforwork.com.

b. Right-click chromeforwork.com and select Create a GPO in this domain...

c. Create anew GPO policy called Google Update for Work.
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4. Navigate to the newly created GPO object:

a.

Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Google Update for Work.
Right-click Google Update for Work and select Edit to load the Group Policy Management

Editor.

5. Add the ADM/ADMX policy template for Google Update to the GPO object in Group Policy
Management Editor:

a.

b.
C.
d

Find Computer Configuration > Policies > Administrative Templates...
Right-click Administrative Templates, and select Add/Remove Templates.

Add the GoogleUpdate.adm template via the dialog.

Once complete, a Google / Google Update folder will appear under Administrative
Templates if it's not there already.

File Action View Help

e @ = B0 T

12/ Google Update for Work [2012R2STD.CHROMEFORWOR A  Preference: :
4 % Computer Configuration e
4 (51 Policies Select an item to view its description. _Sfttmg
b [ Software Settings 2] Auto-update check period override
b B Windows Settings 2] Download URL class override
4 [ Administrative Templates: Policy definitions (
b ] Control Panel
b 2] Metwork
1 Printers
1 Server
[ Start Menu and Taskbar
b 2] System
b [ Windows Components
4 [ Classic Administrative Templates (ADM)
4 [ Google
4[] Google Update

[0 Preferences |
1 Proxy Server
b 7] Applications

6. Enforce the GPO object:

a.

Find Group Policy Management > Forest:chromeforwork.com > Domains >
chromeforwork.com > Google Update for Work.

b. Right-click Google Update for Work and select Enforce.

7. Assign the Google Update GPO to the same set of users as the Chrome Browser GPO:

a.

Navigate to the Google Update For Work GPO object in the Chrome Policy Management

tool.
i.  Find Group Policy Management > Forest:chromeforwork.com > Domains >

chromeforwork.com > Google Update for Work and select it.

b. Assign the GPO object to all devices in the domain.

i. Inthe Security Filtering pane, click Add.

ii. Inthe Select User, Computer, or Group window, type the name of the object you
want to add, click Check Names (to verify the name you entered), and click OK.

iii. You can type Domain Computers to add all workstations and servers joined to this
domain (as in the example below) or you can specify a different group of
computers.
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Test your installation

Test if Chrome Browser is automatically installed on the target machine:

1. Start the assigned client machine.

2. When the client computer restarts, the managed software package is automatically installed.

3. Ifit does not install, open the command prompt and run the following command:
gpupdate /force

4. Restart the computer.

5. On client machine, launch Chrome Browser. The settings you applied in step 3 should be noticeable
on the test machine. Congratulations!

6. To further verify the policies being applied to Chrome Browser and the user signed-in, go to the
address: chrome://policy to see all policies being applied.

B - O
[ Policies %\ -
« C # [ chromey/policy =
Paolicies

f Reload policies ] [_] Show palicies with no value set

Chrome policies

Applies to Level Source Policy name Policy value Status
Machine Mandatory Platform HomepagelsMewTabPage  ftrue oK
Machine Mandatory Platform Homepagelocation httpy//news.google.com oK
Machine Mandatory Platform RestoreOnStartup 4 OK
Machine Mandatory Platform RestoreOnStartupURLs Show value OK

Machine Mandatory Platform ShowHomeButton true oK

If the policies have not propagated to the test machine / user, you may be able to run “gpupdate” to refresh
policy settings.

On the client machine, use REGEDIT to view the registry settings:

e The client workstation settings are held at
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome
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Example Customer Configurations

Healthcare organization in a regulated’ environment

Chrome Browser Configuration
The following were set through GPO policies unless otherwise noted:

Regulation focused

e Disabled the sending of crash information and anonymous usage statistics to Google
Disabled autofill

Disabled translate

Disable Chrome sync

Disable SearchSuggest

Blocked installation of Data Saver extension

General configuration

e Configure LBS on machines, due to a few legacy web applications, to launch IE when needed to
based on a known list of incompatible apps

e Show Home Button on the toolbar

e Set the homepage to internal intranet portal

e New tab defaults to the homepage

Software Management Configuration

e Pushed package via existing software distribution mechanism for Windows

e |T maintained a set of test machines on beta channel to ensure all core web applications used by
the business function correctly before the next stable release

e Turned on auto update with Google Update but have a policy template ready (and tested) to stop
updates if an issue occurs

Deployment Decisions

e Deployed the package on initial pilot machines without any PIl information

e Adjusted group policies based on testing and feedback from users while reviewing any policy
changes for impact to HIPAA compliance

e Partial deployment to early adopter machines to test deployment with revised policies, including
machines collecting PIl information

e Deployed to the entire user base after three months of testing by early adopters, location by
location over the next 6 months

1. This example configuration is for informational purposes only. Google does not intend the information or recommendations in this

guide to constitute legal advice. Each customer should independently evaluate its own particular use of Chrome Browser with
enforced policies as appropriate to support its legal compliance obligations.
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Public organization with 15,000 users

Chrome Browser Configuration

The following were set through GPO policies unless otherwise noted:

e Disabled Extensions and the Default Browser check

e Internet Explorer Favorites and History were not imported

e Changed the default search engine to Google

e Altered the Group Policy Object (GPO) to allow Chrome Browser to self-update on a scheduled
basis once the latest version was released and internally tested and approved

e (Changed the registry to use Chrome Browser for all mailto: links in any browser so mail links users
clicked on will load in Gmail

Software Management Configuration

e Created a desktop shortcut pointing to “email.domain.com” with custom text
e Created shortcuts to additional services in the Windows Start bar: Calendar, Contacts, Documents,
Groups, Mail, Sites, and Video

Deployment Decisions

Background: During the deployment process, a new version of Chrome Browser was released.
e Performed two partial deployments with previous version of Chrome Browser
o First to approximately 8% of their client machines and then incorporated feedback
o Second to 25% of their client machines
e Performed a Full deployment of the current version of Chrome Browser over the course of two
weeks prior to their G Suite go-live
e Allowed the client machines on the previous version of Chrome Browser upgrade to the latest
version by enabling the auto-update GPO
e Once all machines were on the latest version of Chrome Browser, the GPO to disable auto-updates
was enabled

Chrome Browser Deployment Guide | May 2019 28



@ chrome enterprise
Global enterprise of more than 35,000 users

Chrome Browser Configuration

The following were set through GPO policies unless otherwise noted:
e Used a master_preferences file to disable the default browser check

Software Management Configuration

e Changed the registry to allow Chrome Browser to self-update at a 14 day interval
e With their distribution software they created a shortcut on the desktop to open the URL
“email.domain.com” with Chrome Browser

Deployment Decisions

Deployed the package on a few initial pilot machines and all their base images

Made changes to the package based on feedback from the testing deployment

Partial deployment to 400 of their client machines to test the deployment of the package
Full deployment to the entire user base over a 48 hour period

Global enterprise of more than 25,000 users

Chrome Browser Configuration

The following were set through GPO policies unless otherwise noted:
e Due to legacy web application requirements, customer chose to disable default browser check via
master preference file
Configured to update once a week
Show Home Button on the toolbar
Enabled and set the default search provider to Google
Set the homepage to www.google.com

New tab defaults to the homepage
Disable the password manager
Three tabs opened on the browser launch to (Mail, Sites, Help Site)

Configure auto-update to check once per week

Software Management Configuration

e Push package via software distribution or batch file along with Google Talk Plugin
e Package distribution handled through LANDesk via an Autolt script
e Disabled placing an icon on the desktop via software distribution
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Deployment Decisions

Development of the package on 20 initial beta users

Made changes to the distribution script based on feedback from the pilot group. Customer decided
to use distribution script rather than alter the package (LANDesk)

Current iterations remove previous Chrome Browser packages as a safeguard

The Chrome Browser package was pushed to a pilot of 200 users to ratify installation and settings
Further deployment was based on the G Suite rollout schedule. General practice was to push
Chrome Browser to users two weeks before they were migrated to Gmail

Commercial organization with 1,000 users

Chrome Browser Configuration

The following were set through policies unless otherwise noted

Used a master_preferences file to set default homepage to company Sites page to help users know
where to start

Use vbscript to set default mail handler to Chrome Browser so when users click on mail links in an
application or browser it opens Gmail

During testing an hourly check-in for updates was configured, after testing a 7 day interval was
chosen

Deployment Decisions

Created a test organizational unit and added a few pilot machines
Adjust group policies based on testing and feedback
Full deployment to the entire user base before the G Suite Go-Live
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Additional Resources

Google Chrome Enterprise Help Center
A collection of help articles covering deployment and frequently asked questions.

Download Chrome Enterprise Bundle

Information about the single package that contains all the tools and components you need to deploy
Chrome in your enterprise.

Chrome Enterprise release notes
Details about improvements and other changes in stable Chrome Browser releases.

Legacy Browser Support
Learn how to switch between Chrome and legacy sites that require Internet Explorer.

Chrome Browser Cloud Management
Information about how to securely manage Chrome Browser from the Admin console.

Managing Extensions in Your Enterprise

Best practices for managing Chrome Browser extensions in your organization.

Chromium Documentation for Administrators
A source of detailed documentation and common problems.

Chrome version
The current version per platform and release.

Remotely install software (Microsoft KB)
Use Group Policy to remotely install software in Windows Server 2008 and Windows Server 2003.

Get support

Details about what we support with Chrome for business.

Windows Quick Start Guide
Answers to many common questions for IT administrators when rolling out Chrome Browser.
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